
RELEASE NOTES

Release Notes for Nuke and Hiero
11.0v4

Release Date
24 January 2018

Qualified Operating Systems
• Mac OS X El Capitan (10.11) or macOS Sierra (10.12)

• Windows 7 or Windows 10 (64-bit)

• CentOS 6 or CentOS 7 (64-bit)

NOTE: If you intend to use floating licenses with Nuke 11, you'll need to upgrade the version
of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge
Base article Q100320 for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
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• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA
GPU. Driver version r361 or above is required.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you
don't have it already. The minimum requirement is driver version r361 which can be downloaded
from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

Windows GPU Driver Linux GPU Driver

AMD FirePro W8100 17.Q2.1 AMD FirePro W8100 17.Q2.1

AMD FirePro W9100 17.Q2.1 AMD FirePro W9100 17.Q2.1

AMD Radeon R9 Fury X 17.4.3 - 17.6.2 AMD Radeon R9 Fury X 17.10

AMD Radeon RX 480 17.Q2.1 AMD Radeon RX 480 17.Q2.1

AMD Radeon Pro WX 7100 17.4.3 - 17.6.2 AMD Radeon Pro WX 7100 17.10

NOTE: Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016
MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

MacGPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and
late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-
GPU support option. When enabled in the preferences, GPU processing is shared between the
available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend
updating Mavericks to 10.9.5, or above for full functionality. However:
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• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 143908/157989 - Expressions: A new Performance > Expressions >Mode preference has
been added, controlling how expressions in the Node Graph are evaluated. After an initial
evaluation on all expressions to find dependencies, the default mode, Lazy, only re-evaluates
expressions when needed. This can help with UI performance in some circumstances.

If you require constant expression evaluation, set theMode to Always, which causes Nuke to
behave as in previous releases.

• BUG ID 169843 - BlinkScript: An error message is now printed in the Viewer, as well as in the initial
error dialog, providing more information about compilation errors.

• BUG ID 173220 - The BlinkScript node and soft effect now support float3x3 and float4x4 matrix
constructors.

Bug Fixes
• BUG ID 132111 - Crop: Linked expressions within the box controls didn't evaluate the expressions
correctly.

• BUG ID 145446 - Using a custom viewerProcess displayed a Bad value for colorspace error.

• BUG ID 157428 - Opening a script with an invalid viewerProcess displayed a RuntimeError.

• BUG ID 159877 - Soft Effects: Keyframes in exported .nk scripts were occasionally offset incorrectly.

• BUG ID 160138 - Mirror: Adding a Mirror node to a script cropped the bounding box to the visible
format, discarding overscan.

• BUG ID 161753 - Custom viewerProcesses were not ignored in terminal mode.

• BUG ID 163781 - Nuke Assist: TimeOffset nodes did not work as expected until the script was saved.

• BUG ID 167962 - Soft Effects: BlinkScript effects containing unsupported kernels caused Nuke to
become unresponsive.
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• BUG ID 167977 - Soft Effects: BlinkScript effects did not work as expected if the local GPU did not
support OpenCL or CUDA.

• BUG ID 169841 - Soft Effects: The BlinkScript effect did not accept parameter names containing a
leading underscore.

• BUG ID 171095 - BlinkScript: Compilation error messages were not dismissed from the Viewer when
the error was addressed.

• BUG ID 199893 - CornerPin: Expression linking controls using Tcl did not work as expected.

• BUG ID 216806 - The public DD::Image interface for the OCIOColorSpace node could not initialize
certain values and occasionally caused Nuke to crash.

• BUG ID 221017 - Opening a script with a missing viewerProcess LUT from the terminal did not work
as expected.

• BUG ID 224117 - MatchGrade: Changing the Analysis type in a customer script caused Nuke to
crash.

• BUG ID 238873 - Deep: Viewing the depth channel in a customer script caused Nuke to crash.

• BUG ID 246196 - Deep: Processing Deep nodes was occasionally slower on NVIDIA Quadro series
GPUs.

• BUG ID 246227 - Reading certain large resolution images at certain zoom levels caused Nuke to
crash.

• BUG ID 263785 - Monitor Output: Gaps between UHD/4K shots on the timeline added dissolves
incorrectly when output to an HDMI 4K TV.

• BUG ID 266300 - Create Comp: Exporting multiple shots to the same comp didn't use the correct
start frame.

• BUG ID 272435 - Windows only: Setting a Comp Disk Caching > temp directory in the Preferences
caused Nuke to become unresponsive.

• BUG ID 274184 - Nuke's version number was incorrect in the command line.

• BUG ID 275417 - Create Comp: Exporting a single comp containing multiple clips ignored Custom
frame range values.

• BUG ID 275698 - macOS only: Adjusting the analysis area in a Denoise node caused Nuke to crash.

• BUG ID 275718 - Deep: Rendering a DeepWrite that referenced a DeepRead with no file specified
caused Nuke to crash.

• BUG ID 279107 - Denoise: Setting temporal processing to ≥ 4 displayed CUDA errors.

• BUG ID 279446 - LensDistortion: The 3DE Radial Fisheye preset produced splatting artifacts in
Undistortmode.

• BUG ID 279589 - LensDistortion: Adjusting a feature after solving a lens using manual lines and then
reformatting to 8K, caused the feature to move erratically.

• BUG ID 280058 - LensDistortion: Backwards distortion models behaved differently to forwards
distortion models with Reformat nodes and bounding boxes.
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• BUG ID 281996 - LensDistortion: The add line preview overlay remained visible when undoing an
add line action with the overlay visible.

• BUG ID 285065 - Linux only: Certain NukeX nodes displayed a progress bar indefinitely.

• BUG ID 304710 - Linux only: Analyzing and tracking in PointCloudGenerator displayed a blank
Progress dialog over the top of the working Progress dialog.

• BUG ID 304723 - Export: The Version token number field in Nuke Studio did not accepted 00 as a
version number.

• BUG ID 306303 - Export: The all tracks option in Nuke Studio's Export dialog included disabled
tracks in the output.

• BUG ID 308779 - Timeline Editing: Adjusting timeline In and Out points caused the timeline to
recache, degrading performance.

• BUG ID 310034 - LiveGroups: Clicking Reload in the Properties of a LiveGroup containing User
knobs returned unlinked knobs to the default value.

• BUG ID 310292 - Switching shot version in the timeline using the Alt+up or down keyboard
shortcuts only worked once.

• BUG ID 310512 - macOS only: Dock icons were occasionally grayed-out after closing and reopening
the application.

• BUG ID 310594 - Deep: The DeepToPoints node did not generate a point cloud correctly when a
Camera was connected.

• BUG ID 312397 - Wiping between two images with Use GPU for viewer when possible enabled in
the Preferences, stopped the Viewer gain and gamma controls having any effect.

• BUG ID 312944 - Clamp: Adjusting theminimum control clamped to incorrect values.

• BUG ID 312983 - Linux only: Canceling and restarting a CameraTracker progress dialog created
multiple blank progress dialogs.

• BUG ID 314258 - Deep: Merging two ScanlineRenders using DeepMerge created artifacts in the
depth pass.

• BUG ID 315478 - Windows only: The Clamp node did not clamp negative values to 0.

• BUG ID 316775 - PlanarTracker: Selecting a CornerPin2D track type in the control above the Viewer
caused Nuke to crash.

• BUG ID 316797/321837 - Nuke and Nuke Studio printed multiple Qt errors in the terminal during
normal operation, such as QPainter and QOpenGLContext.

• BUG ID 317082 - Timeline Disk Caching: The invalid cache warning displayed even when the
database was empty.

• BUG ID 318107 - Timeline Editing: Muting an audio track caused pointer moves to scroll up and
down in the timeline.

• BUG ID 320055 - Audio: Adding certain .mp4 encoded source clips to a sequence did not playback
audio correctly.
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• BUG ID 321018 - Export: Transcoding to the .tga format with the Channels control set to all did not
work as expected.

• BUG ID 322487 - LiveGroups: The Open button did not work as expected with relative file paths.

• BUG ID 324851 - Monitor Output: Using legal ranges in the Node Graph didn't work as expected with
Blackmagic cards in 10-bitmode.

• BUG ID 328101 - Enabling read file in the Write node Properties panel after rendering caused Nuke
to crash.

New Known Issues Specific to this Release
This section covers new known issues and gives workarounds for them, where appropriate.

New Known Issues Specific to Nuke
• You may experience issues when importing PySide modules into their Python scripts due to the
migration from PySide 1.2.2 to PySide 2.0.

In some cases, you can just change calls to:

import Pyside.some_module

to:

try:

    import Pyside.some_module

except:

    import Pyside2.some_module

However, the definition of some classes has moved between modules in PySide 2.0. This particularly
affects any Widget related classes, which have been moved from QtGui to QtWidgets, however there
are other cases where this may be experienced.

If you experience any problems with this, please refer to the Qt 5.6.1 documentation, or contact
support.foundry.com.

• BUG ID 308576 - Windows 10 only: The installer does not place launch icons in a version folder in
the Startmenu.

• BUG ID 282593 - VFX Platform: Switching to a fullscreen workspace on the primary monitor
occasionally causes the secondary monitor to turn black.

• BUG ID 280371 - Mac OS X/macOS only: OpenGL errors are printed on the command line when
using an ATI Radeon 5770 GPU.
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• BUG ID 277548 - VFX Platform: A QComboBox with a custom QCompleter currently emits incorrect
signals.

• BUG ID 275719 - Mac OS X/macOS only: The Help > About Nuke pop-up is positioned incorrectly on
some machines.

• BUG ID 274301 - VFX Platform: Node toolbar menu items do not always deselect correctly.

• BUG ID 274264 - VFX Platform: CameraTracker results from Nuke 11 are not identical to previous
versions of Nuke, though the differences are negligible.

• BUG ID 274174 - LiveGroups: Reloading a LiveGroup currently resets all edited User knobs.

• BUG ID 273472 - Frame Server: Canceling or pausing a comp render in the Background Renders
panel displays errors in the terminal.

• BUG ID 273462 - Licensing: Nuke cannot retrieve a license from the license server when the
hostname contains .local.

• BUG ID 272767 - VFX Platform: Launching Nuke from the terminal with the -b argument has been
deprecated as a result of library upgrades to comply with the VFX Platform 2017 requirements.
There are two workarounds available on Mac and Linux :

• Run Nuke from the Terminal with & added to the launch command. This allows Nuke to run in
the background and returns the command prompt, but closing the Terminal still causes Nuke to
close. For example:
./Nuke11.0v1 --studio &

• Run Nuke from the Terminal using the nohup command. This allows Nuke to run in the
background and returns the command prompt, but closing the Terminal does not cause Nuke
to close. For example:
nohup ./Nuke11.0v1 --studio &

TIP: The nohup command prints output to /Users/<username>/nohup.out or
/home/<username>/nohup.out by default, but you can specify a different file by appending
> /filepath/filename to the command. For example:

nohup ./Nuke11.0v1 --studio & > /Users/<username>/nuke.out

• BUG ID 272750 - VFX Platform: The remove all panels button in the node Properties panel is
displayed inconsistently.

• BUG ID 272523 - Frame Server: Non-contiguous frame ranges cannot currently be flipbooked.

• BUG ID 272442/281108 - VFX Platform: The Licensing dialog jitters when moved around the screen.

• BUG ID 272296 - Adding a user knob and then undoing the action doesn't remove the added knob.

• BUG ID 272281 - LiveGroups: Adding a user knob and then undoing the action sets expression links
to nodes with matching names in main Node Graph.

• BUG ID 272274 - VFX Platform: Closing Nuke Studio does not remove the application icon from the
task bar.
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• BUG ID 271807 - Linux only: Adjusting pane or window borders left and right causes redraw lag.

• BUG ID 271804 - Documentation: The node Properties panel ? link to the reference documentation
doesn't work as expected.

• BUG ID 271632 - VFX Platform: Nuke prints a libDeckLinkAPI.so error in the terminal on launch.

• BUG ID 271456 - UI: Some interface elements appear larger than usual when compared to previous
versions of Nuke.

• BUG ID 271435 - Flipbook: Using the flipbook with nuBridge installed causes Nuke to crash.

• BUG ID 271373 - A QOpenGLContext::swapBuffers() called with non-exposed window, behavior
is undefined error is occasionally printed on the command line.

• BUG ID 271256 - Denoise: Rendering frames to disk with a Temporal Frame Offset greater than 1
causes Nuke to crash.

• BUG ID 270776 - Linux only: QWebEngine is currently missing from the Qt 5.6.1 build.

• BUG ID 271074 - PointCloudGenerator: Track Points does not work as expected when creating a
point cloud from CameraTracker data.

New Known Issues Specific to Nuke Studio and Hiero
• BUG ID 282599 - Linux only: Input and timecode metadata is currently incorrect in the timeline
Viewer if the framerate is changed.

• BUG ID 280413 - Soft Effects: The Text effect cursor placement shifts incorrectly after typing first
character.

• BUG ID 280256 - Timeline Disk Caching: Opening a Text effect's Properties panel directly after
project load causes the cache bar to disappear.

• BUG ID 278312 - Read/Write: The import progress bar occasionally persists after the import is
complete, and cannot be closed.

As a workaround, save and close the project, then restart Nuke Studio and reload the project.

• BUG ID 278275 - Soft Effects: Closing a Timewarp effect's Properties panel disrupts the interface
briefly.

• BUG ID 275314 - Soft Effects: Additional keyframes are added incorrectly when animating Text
effects.

• BUG ID 275251 - Mac OS X/macOS only: Hovering over clip instances in the timeline does not change
the pointer icon.

• BUG ID 275246/270914 - VFX Platform: The terminal or command line displays libpng warning:
iCCP: cHRM chunk does not match sRGB on startup.

• BUG ID 274824 - AAF: Elastic keyframes imported from Avid do not translate correctly into Nuke
Studio.

• BUG ID 272897 - Timeline Caching: Caching continues after closing the project associated with the
frames being cached.

Release Notes for Nuke and Hiero 11.0v4 | New Known Issues Specific to this Release



RELEASE NOTES
9

• BUG ID 272723 - Closing Nuke Studio when it was launched from the command line does not end all
Nuke processes.

• BUG ID 272541 - Timeline Caching: Changing the root directory for cached files can cause the disk
cache state to become inconsistent.

• BUG ID 272504 - VFX Platform: The timeline Viewer in and out point previews are not working as
expected when scrubbing.

• BUG ID 272450 - Timeline Caching: A TimelineCache folder is added incorrectly to the Nuke install
directory.

• BUG ID 272338 - VFX Platform: The Windows command prompt displays QWidget::paintEngine:
Should no longer be called on launch.

• BUG ID 270934 - Timeline Caching: The caching logic does not currently account for gaps in
sequences, resulting in the caching state icon remaining gray for fully cached sequences.

• BUG ID 269150 - ARRIRAW: ProRes clips from the Alexa SXT camera cannot currently be read by
Nuke Studio.
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Other Known Issues
This section covers legacy known issues and gives workarounds for them, where appropriate.

Known Issues Specific to Nuke

AudioRead

• BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled
between file and custom.

• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.

• BUG ID 18465 - The time range control doesn’t limit the range when an endtime is specified.

• BUG ID 18451 - Flipbooking doesn't honor the time range knob.

• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.

• BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn't redraw the curves
correctly.

BlinkScript/CUDA

• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA
error when the OS wakes up from sleep mode.

As a workaround, close and reopen Nuke to reactivate the CUDA drivers.

CameraTracker

• BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez
modes.

• BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image
in reference thumbnails, rather than just the RGB values.

Deep

• BUG ID 43383 - Executing a script in command-line mode that reads in a deep image and then
writes it to disk, causes Nuke to crash.

As a workaround, run the script from the Script Editor inside Nuke.

• BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1.
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As a workaround, preview the .exr in the file browser before reading it into Nuke.

Dope Sheet

• BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you
execute Analyze Sequence with the Dope Sheet open.

• BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.

• BUG ID 39426 - Undoing individually animated text characters removes their keys completely from
the Dope Sheet.

• BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames
when frame snap is enabled.

• BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.

• BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to
have a non-empty frame expression.

• BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated.

• BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented
once in the Dope Sheet.

EditGeo

• BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on
geometry with animation baked into its vertices.

To update the transform handle, toggle the axis alignment control between object and average
normal.

• BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to
ignore the EditGeo node.

• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe
marker.

• BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and
corner vertices.

Flipbook

• BUG ID 201156 - Nuke's flipbook defaults to the Write node's colorspace, which can result in
different output when compared to the Viewer.

As a workaround, either flipbook the node upstream of the Write node, or enable Burn in the LUT
in the Flipbook dialog.
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• BUG ID 47005 - In the Flipbook Viewer, clicking the Go to start button always goes to frame 0, even
if the clip doesn't start at 0.

• BUG ID 47005 - Enabling Burn in the LUT in the Flipbook dialog uses the rec709 LUT for both
rec709 and rec1886.

GPU

• BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.

Import Nuke

• BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command-line
arguments unavailable.

As a workaround, preserve sys.argv in another variable before you import Nuke.

• BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other
applications.

• BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is
available.

Linux Only

• BUG ID 199990 - In some situations NVIDIA Quadro Linux drivers 319.23 can cause Nuke to hang
during start up.

As a workaround, update your drivers to 361.42.

• BUG ID 49262 - Scrubbing in the timeline in large projects can force memory use to hit 100%,
causing Nuke to become unresponsive.

• BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.

As a workaround, launch Nuke from the command-line using:

LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0

• BUG ID 42581 - Keyboard Shortcuts: Using Ctrl+C to quit Nuke from the command-line when a
dialog box is open displays an error.

• BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

Mac OS X Only

• Installation - If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA
CUDA drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers
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directly from NVIDIA here:

http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html.

• BUG ID 228076 - The PySide QtUiTools library is currently missing from the Nuke build.

• BUG ID 163543 - Mac OS X 10.11 only: Dragging handles in the 3D Comp Viewer can be slow to
respond.

• BUG ID 50371 - Script corruption can occasionally occur on Mac OS X 10.9 (Mavericks), and above,
when writing to SMB 2.1 and SMB 3 Sharepoint locations.

• BUG ID 50182 - Nuke cannot be launched from the Finder if it has already been launched from the
Terminal.

• BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.

• BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when
you click Save Report.

• BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than
one instance of Nuke at the same time, can cause display corruption and/or entire system freezes.
This seems particularly likely to occur on GPUs with low amounts of RAM, such as the GeForce GT
650M.

As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU
acceleration in one instance of Nuke at a time.

• BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure
X11 is installed on your system. Unlike previous versions of OS X, 10.8 and above do not have X11
installed by default.

For more information, see http://support.apple.com/kb/HT5293.

• BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.

As a workaround, either:

• tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or
Samba, depending on source), or

• using the command-line, copy the installation from Mac OS X to the network location using the
same file system as the destination.

• BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.

As a workaround, adjust the Viewer gain control to refresh the Viewer.

• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script,
except when Nuke is run from the command-line.

• BUG ID 13638 - The following graphics cards are not currently supported for Mac:

• ATI Radeon X1600

• ATI Radeon X1900
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Users with these cards are able to render from the command-line, but in GUI sessions, the Node
Graph renders incorrectly due to a requirement of OpenGL 2 drivers.

• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.

• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder

• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.

• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry
through a ScanlineRender node causes Nuke to crash.

Monitor Out

• BUG ID 250107 - Monitor Output: 10-bit output from Blackmagic DeckLink HD Extreme 3D+ cards at
the extents of color ranges is incorrect.

As a workaround, using the Desktop Video Setup utility, ensure that the SDI Settings 4:4:4 RGB
checkbox is enabled and the SDI Configuration is set to Single Link.

• BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash.

• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

OCIO

• BUG ID 201193 - Read nodeMetadata tabs occasionally include irrelevant in and out colorspace
controls.

Particles

• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to
geometry, does not render all frames to the .nkpc file.

• BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is
out-of-date errors for negative frame numbers.

• BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off
are not reliably cleared when rendering through ScanlineRender.

• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been
calculated within the particle system.

• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.

• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.
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• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind
the 3D grid lines.

Pixel Analyzer and Scopes

• BUG ID 44176 - PixelAnalyzer: The full frame samplingmode doesn't work immediately in the
timeline Viewer when the analyzer is initially added to the layout.

• BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the
Viewer bounding box to 1x1 for that frame.

• BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.

• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include
viewer color transforms is enabled.

PrmanRender

• In the Nuke camera, the window roll control is not yet mapped to RenderMan.

• BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plug-
in the environment.plist file when in GUI mode.

See http://support.apple.com/kb/TS4267 for more information.

Python

• BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes
Nuke to crash.

• BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when
run from the command-line.

Run the script from Nuke's Script Editor to avoid this issue.

• BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.

• BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the
command-line.

To work around this issue, run the Python script from Nuke's Script Editor.

• BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports
incorrect values.

As a workaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are
currently selected in the Node Graph.

• BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first
created if it has an autolabel.
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• BUG ID 8063 - Creating many new nodes with nuke.createNode() and the in-panel argument at
default (True)may crash when too many node control panels are created too quickly. The
workaround is to pass the in-panel argument as False or else use nuke.nodes.NodeClass() (where
NodeClass is the type of node to create) to create the node and then connect it to the currently
selected node manually.

• BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the
Script Editor as that can cause Nuke to crash. Instead, you can use the same command from your
menu.py, restore layouts by selecting Layout > Restore Layout, or use a custom menu or toolbar
item.

• Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:

groupName.NodeName.knobname: unexpected 'k' in '0.knobname'

The problem is most likely that there is an expression using the input TCL command and doesn't
validate that there is an input connected. An example expression:

[input parent 0].translate.x

The input command returns 0 when it can't find the requested input, which generates an expression
of '0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the
value TCL command and specify a default value to return in the case that the expression is invalid. It
takes the form:

[value [input parent inputnumber].knob defaultValue]

Here is the modified example:

[value [input parent 0].translate.x 0]

The modified example returns 0 in the event that there is no input 0, and no longer results in an
error message.

• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>()
if the knob is called 'in'.

For example, this gives a syntax error:

nuke.nodes.Shuffle(in = 'depth')

while this works because 'in' is a string here and not a keyword:

sh = nuke.nodes.Shuffle()

sh['in'].setValue('depth')
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RayRender

• BUG ID 230256 - Soft Shadows are not currently supported.

• BUG ID 197294 - Reflection occlusion is not currently supported.

• BUG ID 196980 - Clipped alpha shadows are not currently supported.

• BUG ID 196776 - Multiple bounce reflecton is not currently supported.

• BUG ID 196124 - RayRender does not currently support refraction.

• BUG ID 195051 - The Wireframe shader node, located in 3D > Shader >Wireframe, is not
supported by RayRender.

• BUG ID 195004 - Custom lens shaders/projection modes are not currently supported.

• BUG ID 194819 - RayRender does not currently support Deep workflows.

• BUG ID 191108 - Particle sprites are not currently supported.

• BUG ID 174849 - The Displacement shader node, located in 3D > Shader, is not currently supported
by RayRender.

Read and Write

• BUG ID 50046 - The default colorspace values when writing using .mov codecs differ in command-
line and GUI modes.

• BUG ID 48935 - MXF: Importing a certain JPEG2000 file causes Nuke to crash or display the file
incorrectly.

• BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.

• BUG ID 47248 - MXF: Setting debayer quality to High Quality on some Sony RAW files displays an
error decoding frame message in the Comp Viewer.

• BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the
rgba channels by default.

• BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.

• BUG ID 40684 - Rendering certain h264 encoded .mp4 files using themov32 encoder results in color
shifts using QuickTime 10.3 codecs.

• BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to
ProRes 4444.

• BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes
correctly.

• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect
while toggling the read transform from file in combination with all objects and/or read on each
frame.
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• BUG ID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a
superfluousmain view.

• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to
neighboring faces, leaving gaps in certain circumstances.

This issue is particularly visible when using the EditGeo node, which should not allow you to remove
faces from the geometry.

• BUG ID 31424 - Sub-sampling in .exr files is not currently supported.

• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc
files.

As a workaround, ensure that ReadGeo > read on each frame is enabled.

• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new
views to the project, subsequent reads of any stereo/multiview .exr files won’t give the option to add
new views.

• If you have trouble with FBX files, it may be because they were written with an older version of FBX.
If they load very slowly, it is also possible that they are ASCII rather than binary. To get around these
problems, you can use the FBX converter on the Autodesk website. It converts between various
different formats, including older FBX versions, ASCII, and binary, and is available on Windows, Mac
OS X, and Linux.

To download the FBX converter:

1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775855.

2. Scroll down to FBX Converter and click on one of the links to start the download.

Render codecs

Rendering with certain codecs occasionally causes Nuke to crash. Due to this, we recommend the
following:

• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec
instead. If you're unable to switch to Sorensen Video 3, try using a format smaller than 2K for better
performance.

• If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or
above. You may need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx.

• If you're using Avid Meridien, you should only write out in NTSC and PAL.
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Roto/RotoPaint Open Splines

• BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the
feather handles in the Viewer.

• BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.

As a workaround, select the shape and then manually change the Properties view control to include
both views.

• BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.

• BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative
feather values.

• BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave
erratically.

• BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects
in the hull or feather.

• BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally
produces artifacts in the spline's hull.

• BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is
set to 0.

• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.

• BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight
rendering glitches inside the hull.

• BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width
changes greatly from one point to the next

• BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open
Spline and Bezier tools.

Other Roto/RotoPaint Bugs

• BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint
color.

• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo
the keyframe creation.

• BUG ID 32450 - RotoPaint Stereo: Attempting to undo multiple split-control transforms on the same
shape reverts the shape to its original position.

• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t extend to the current frame,
disappear when drag-selected.

As a workaround, select the shape in the curves list to re-display the points.
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• BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected.

NOTE: This also applies to SplineWarp matrices.

• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent
shapes for a single smooth operation.

• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.

• BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke
8, but bear in mind that they won’t be backwards compatible with Nuke 6 once converted, unless
you follow the instructions below:

Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:

• Click Save As to convert the script to the Nuke 8 Roto format, or

• Click Ignore to load the Nuke 6 format into Nuke 8. You might select this option if:

- You don't intend to make any changes, or

- You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.

If you want Nuke 8 scripts to load in Nuke 6, use the convertToNuke6 or
convertDirectoryToNuke6 Python functions when running Nuke 8 in command-line only mode:

NOTE: The conversion functions cannot convert stereo-split curves as they are not
supported by Nuke 6.

• To convert individual .nk scripts:
convertToNuke6(fromScript, toScript, overwrite = False)

• To convert all .nk scripts in a given directory:
convertDirectoryToNuke6(fromDir, toDir, matchPattern =.*\.nk, overwrite =
False)

NOTE: The pattern is a regular expression.

An example single script conversion and rename to the same directory, from the command-line (or
Terminal):
$ <NukeInstallDir>/Nuke8.0v1 -t

>>> import nuke.rotopaint

>>> nuke.rotopaint.convertToNuke6(/tmp/myRoto8.nk, /tmp/myRoto6.nk)

• BUG ID 26855 - The undo and redo buttons in the Properties panel didn’t work as expected and
have been disabled.

The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the
Editmenu instead.
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• BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another
frame.

• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.

• BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of
the screen.

• The foreground onion skin overlay updates as you paint, rather than only updating with the new
stroke on pen up.

• It is not currently possible to clone RotoPaint nodes.

• Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled
on the layer you are working in.

ScanlineRender

• BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.

• BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in
semi transparent areas.

• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an
image.

SmartVector Toolset

• BUG ID 196455 - Rendering vectors after correcting the file control in the SmartVector node
occasionally displays a spurious No such file or directory error.

As a workaround, scrub to a different frame to remove the message.

• BUG ID 175605 - Entering a partial file path in the SmartVector file control and then clicking the file
browser icon does not open the file browser.

As a workaround, click OK on the error message and then click the file browser icon again.

Text

• BUG ID 48418 - Different operating systems handle the Shadows tab shrink/expand control
differently, producing inconsistent output.

• BUG ID 39556 - In text editmode, it is not currently possible to edit text attributes when the Viewer
overlay is disabled.

• BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does
not work as expected.

As a workaround, expression link the translate x and y controls separately.
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• BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.

• BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame
where the character no longer exists, results in the transformation being lost.

• BUG ID 39130 - Splitting themessage field does not work as expected.

• BUG ID 38789 - Viewer toolbar controls steal cursor focus.

• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.

• BUG ID 36372 - Selecting a TCL expression in themessage field doesn't always select the result in
the Viewer.

Tracker

• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back
the tracked frames.

As a workaround, you can enable full frame processing, though this may increase render times.

• BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the
tracking anchor coordinates to 0,0.

• BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.

• BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection.

• BUG ID 38356 - The zoom window occasionally doesn't update correctly when scrubbing between
frames.

• BUG ID 32359/32353 - Right-clicking on a point in the Viewer doesn’t always update the available
Link to > Tracker linkingdialog or Tracker options.

As a workaround, close and re-open the Roto/RotoPaint properties panel to update the Link to
menu.

• BUG ID 29382 - Tracking keyframes with different sized patterns doesn’t work as expected.

As a workaround, keyframe patterns should, where possible, be of comparable sizes.

Warpers

• BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display
an overlay until pen-up.

• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points
to 0,0, which cannot be undone.

• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are
removed.

• BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot
currently be undone.
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• BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to
a new layer.

• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.

• BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to
display the cropped image and the black area between the crop box and the format when merged
over a background.

• BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid
lines.

• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect inmorph mode, whenmix is set
at an intermediate value.

• BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes
rendering problems.

• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when inmorph mode
withmix set at an intermediate value.

• BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather
than just the latest, and the keyframes remain on the timeline and in the properties.

• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.

• BUG ID 19079 - SplineWarp: The C keyboard shortcut does not currently select the Add
Correspondence Point tool.

• BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes,
even if a grid is not visible in the Viewer.

• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different
positions, does not undo as expected.

• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or
Dope Sheet.

• BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new
grid using the Draw Boundary Viewer button.

• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A
shortcut.

• BUG ID 18012 - GridWarp: The grid can flicker between white and gray when zooming in and out of
the Viewer, particularly when the grid is subdivided.

• BUG ID 17697 - GridWarp: In stereo mode, the right view is labeled as default when you split
controls into separate views.

Windows Only

• Nuke Non-commercial: Navigating to Help > License, clicking Deactivate or Deauthorize, and then
clicking Quit, causes Nuke Non-commercial to crash on exit.
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As a workaround, change themode a few times until it work as expected.

• BUG ID 198430 - Nuke cannot read DNxHD .mxf files that have spaces in the file name.

• BUG ID 46759 - File Browser: Location defaults (such as Home, Root, etc.) may not display if you
have a previously saved FileChooser_Favorites.pref file in your ~/.nuke directory.

As a workaround, move or rename the FileChooser_Favorites.pref file, and re-launch Nuke.

• BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you
use the erase end of the pen.

• BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422
(2vuy) pixel format due to a bug in the codec, resulting in solid green frames.

As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity.

• BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node,
such as Primatte or Shuffle, even after the node is removed from the Node Graph.

• BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous

• BUG ID 228258 - Calling fromScript() on a knob that has not been added causes Nuke to crash.

• BUG ID 226394 - Preferences: There are currently duplicate Script Editor controls under Other in
the Preferences dialog.

• BUG ID 169458 - Compositing Viewer: Setting the gamma control to 0 with Panels > Viewer (Comp)
> use GPU for Viewer when possible enabled in the preferences, renders the alpha channel black.

• BUG ID 168350 - AMD GPUs are reported as ATI GPUs in the node properties and --gpulist on the
command line.

• BUG ID 50715 - ZDefocus: Switching the filter type to image causes Nuke to crash in a customer
script.

• BUG ID 49803 - AJA Monitor Output: Setting the NUKE_AJA_CHANNEL environment variable to 4
when the NUKE_AJA_DUALOUTPUT environment variable is set, streams the output to SDI3, rather
than SDI4.

• BUG ID 49186 - ColorCorrect: Adding an expression to the curves on the Ranges tab and then
changing a value, such as Gain, causes Nuke to crash.

• BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is
changed.

• BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system
occasionally allows particles to pass through the bounce surface.

• BUG ID 42339 - TheModo Viewer control scheme (Preferences > Panels > Viewer Handles > 3D
control type) does not work as expected.
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• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel
doesn't work as expected.

• BUG ID 42159 - Nodes that use the Iop::sample() call to get input pixels, such as LensDistortion,
perform poorly when they are downstream of nodes using PlanarIop, such as Denoise.

• BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.

• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the
same name as the file path to the original.

WARNING: If you save this empty script when the network drive is reconnected, the original
is overwritten.

• BUG ID 41122 - MatchGrade:Match Different Clipmode does not allow you to set keyframes on
the Target for .mov clips with a frame range offset.

• BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous
versions.

• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middle-
mouse button, pastes values into the control.

• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the
Nuke<>Mari bridge won't work unless all instances of Project3D are renamed appropriately in the
mari_bridge.py file.

• BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links.

• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the
nodes from the Node Graph.

• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.

• BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format
sizes causes corruption and constant refreshing in the Viewer.

• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.

• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the
script, resulting in error when the path doesn't exist:

Flipbook render failed: viewerCaptureOp: Cannot write to specified path

• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the
captured images.

• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when
mousing over the Viewer.

• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.

• BUG ID 32628 - DeepToPoints: Command-line rendering appears to calculate renders even when
render is set to off.
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• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and
Hiero.

• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output
layer produces corrupt output.

As a workaround, shuffle the depth information to an alternate layer.

• BUG ID 32118 - Card3D: Whenmotionblur is enabled in the properties, FrameHold and TimeOffset
nodes are ignored when connected to the cam or axis inputs.

• BUG ID 31803 - Using Shift+drag on a control’s animation icon only copies the value for the current
frame, not the entire expression.

• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual
bounding boxes for polymesh primitives.

• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes.

• BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it’s unique identifier,
causes the cache to release. Actions such as adjusting the Viewer Gamma, Gain, or channels
dropdown affect the frame hash.

• BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.

NOTE: This known issue only applies to Roto and SplineWarp keys.

• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the
node is copy/pasted in the Node Graph.

• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.

• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a
Scene node only displays the animated Camera in the Viewer. There should be two cameras: one
static and one animated.

• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal
length of the new camera does not match that of the Viewer camera.

• BUG ID 28291 - Nuke crashes on start up if the disk cache location set in the Preferences is no
longer available.

• BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the Viewer with the control panel
open.

• BUG ID 20204 - Multitexturing: When Preferences > Viewers >Multiframe is enabled, increasing
downrez in the Viewer toolbar can cause textures to flicker in the 3D Viewer.

You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.

• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the
Viewer.

• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch
in the Properties panel.
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• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.

• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because
some large polygons are clipped by the front camera plane.

You can minimize this effect by increasing the geometry tessellation max parameter.

• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or
zooming.

• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and
points drawn with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and
the other in 3D mode, and you have the panel for the RotoPaint visible.

• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit
per frame is 50MB. If your frames are larger than this, you may need to switch to proxy mode for
the caching to work.

• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is
not restricted to, any nodes that have an analysis pass.

• BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.

Nuke runs correctly from a network install on Windows without specifically installing the run-time
libraries, though we still recommend that you do so as there are still some minor problems without
them.

• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render.
This question is unnecessary as the result is an anaglyph image. Irrespective of what view you
choose, the flipbook output is the same.

• File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so
if you save a script on NukeX using features that are only included in NukeX (such as CameraTracker
or FurnaceCore) and then double-click on the script icon to open it, it opens in standard Nuke
instead of NukeX.

• CameraTracker: Canceling lens distortion initialization results in corrupt tracks.

• 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node
when using Create Scene:

• Select the Camera that was created in the 3D view when using the Create Scene button.

• Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to
focus (using F) on the point cloud. The resulting tumble camera movement is likely to be jumpy.

• Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were compiled
against an earlier version of Nuke.
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Known Issues Specific to Nuke Studio and Hiero

Create Comp

• Multi-view, such as stereoscopic, is not supported for clip instances created using right-click Effects
> Create Comp.

• BUG ID 47044 - Inserting scripts into comps containing Text nodes using unsupported fonts causes
Nuke Studio to crash when the Text nodes are disabled.

• BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the
comp frame range compared to the annotations precomp frame range.

• BUG ID 41665 - There are currently no options to load or overwrite an existing script when you
select Create Comp.

Exporting

• BUG ID 49024 - Enabling the Collate... options in the Export dialog when exporting ignores the
Media tab Output Resolution setting for the track above, and produces output with incorrect
formatting.

• BUG ID 47828 - Exporting retimed or reversed clips as .xml does not work as expected when
imported into Final Cut Pro.

• BUG ID 46403 - Controls set in the Export dialog Content tab occasionally default to the values
from the Nuke Write Node Content preset.

Linux Only

• BUG ID 239672 - Reading files from NTFS disks/partitions can be extremely slow, particularly for
large files. This is a limitation of Linux NTFS file systems, rather than Foundry products.

We recommend avoiding timeline playback that relies on source footage from NTFS
disks/partitions.

• BUG ID 235327 - CPU usage can reach 100% on a single thread during flipbooking, causing Nuke to
become unresponsive.

• BUG ID 167058 - PulseAudio (ALSA) can cause Nuke Studio to crash or impair playback.

As a workaround, you can stop the pulseaudio daemon:

1. Open /etc/pulse/client.conf

2. Set autospawn = no and daemon-binary to /bin/true. Ensure these lines are not
commented out.

3. Call ps -e | grep pulse to check the process is still running.
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4. Call pulseaudio --kill

5. Call ps -e | grep pulse again to check the process has stopped.

• Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio
on Linux is scheduled for a later release.

• BUG ID 32613 - Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes
Nuke Studio to crash.

As a workaround, ensure that you have the latest NVIDIA drivers installed, available from:

www.nvidia.com/Download/index.aspx?lang=en-us

Mac OS X Only

• BUG ID 39113 - QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and
earlier.

This is a codec issue rather than an application issue.

• BUG ID 34779 - The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to
a conflict with the combination for the umlaut symbol.

To work around this, press Umomentarily before Alt+U.

OCIO

• BUG ID 198348 - Saving and closing a project that uses an OCIO config, and then relocating the Nuke
install path, causes a Could not load OpenColorIO config error on reload.

Preferences

• The Preferences > Path substitution table for cross platform compatibility currently only comes
into effect at project load, not EDL/XML import.

As a workaround, import your sequence and set the Path substitution rule, then save the project
and reload to force the conversion.

Python API

• BUG ID 50113 - QActions are not added to the Editmenu in the menu bar when finding the menu
action by name.

As a workaround, use the objectName (foundry.menu.edit), where possible.

• BUG ID 44394 - Calling hiero.core.addPathRemap() does not work for soft effect file paths.
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Read and Write

• BUG ID 49912 - HieroPlayer: Projects created in version 1.9, or earlier, are not editable in
HieroPlayer 9.0.

• BUG ID 46174 - XML: Shot names are occasionally not imported correctly from Adobe Premiere .xml
files.

• BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the
Rendering preference set to limit renderer.
As a workaround, you can change the preference Performance > Threads/Processes > Rendering
> export renders to no renderer limits to improve rendering speeds. You can also experiment
with the custom renderer limits to adjust performance on your machine.

• BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.

• BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.

• BUG ID 36726 - Executing Clip > Rescan Clip Range displays frame read errors if the rescan adds
frames to the clip.

• BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to
other applications, such as Premiere or Resolve.

• BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default
Nuke layer, such as depth ormotion.

• BUG ID 28067 - Certain formats produce no monitor output, such as 2K 23.98 and 720P 25.

• BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when
added to the timeline.

Soft Effects

• BUG ID 230536 - The Burn-in effect does not maintain a constant text baseline for all characters
when the format is changed.

• BUG ID 175574 - Undo and redo of Properties panel changes can be unreliable if a soft effect delete
is in the same undo stack.

• BUG ID 50442 - TimeWarp: Applying a TimeWarp to a clip instance occasionally causes the
associated sequence bin item to display an error.

• BUG ID 50441 - TimeWarp: Applying a TimeWarp to clip instances retimed to values other than 100%
does not work as expected.

• BUG ID 49771 - Text/Burn-in: Nuke Studio doesn’t warn you if the font used in an effect could not be
found.

• BUG ID 49298 - Burn-in: The Burn-in effect does not auto-update when switching between
sequences until the playhead is moved.
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• BUG ID 49112 - Dissolve transitions do not work as expected in Custom soft effects, based on the
examples provided here:

<install_directory>/pythonextensions/site-packages/hiero/examples/custom_
soft_effect.py

• BUG ID 48970 - Burn-in: Burn-in elements are not updated automatically when the underlying
metadata is updated.

As a workaround, either change the frame displayed in the Viewer or choose an alternate element
from the dropdown controls.

• BUG ID 48878 - Burn-in: The Burn-in effect is currently a gizmo and cannot be cloned on the
timeline.

• BUG ID 48098 - Adding a transition when a Text effect containing an expression is on a track above,
causes text rendering to fail during the transition.

• BUG ID 48097 - Adding a transition when a Text effect containing an expression is on a track above,
causes the text size to reset.

• BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression
writes incorrect frame numbers.

• BUG ID 45835 - Expression links are incorrectly allowed between node and soft effect controls in the
Properties panel, if the node and effect names are identical.

• BUG ID 42438 - Effects are only visible in the Viewer if there is a clip instance below them in the
timeline.

• BUG ID 42401 - Renaming a soft effect does not update the clip instance until you click in the
timeline.

• BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available
using the toolbar button on the timeline panel. The right-click Effectsmenu is currently disabled.

Timeline

• BUG ID 43913 - Locking a track currently prevents adding clip instances from the locked track to the
Viewer input buffers. You can still open clip instances in the various right-click Open In options and
access clip instance metadata.

• BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below
existing tracks.

As a workaround, drag the clip to a new top-level track and then manually move the track to the
required position.

• BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the
right-click Open in Timeline option.
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Windows Only

• BUG ID 49339 - Soft Effects: The background on Burn-in effects, when enabled, alters size
depending on the timecode displayed.

• BUG ID 28701 - Nuke Studio cannot currently parse Unicode characters during export.

Miscellaneous

• BUG ID 200015 - Selecting multiple bin clips can cause the right-click menu to respond slowly.

• BUG ID 167919 - Localization: Re-importing clips into the Node Graph or project bin multiple times
retains the original localization policies settings.

• BUG ID 50490 - Audio: Zooming in on a waveform displays a Failed to decode audio error in the
timeline.

• BUG ID 50102 - Adding a custom Hiero window to a workspace and then saving it as the Nuke
default workspace causes Nuke to crash on start up.

• BUG ID 46235 - Comps with relative paths are not currently working when imported into the project.

• BUG ID 42462 - Cache pausing stops working if any change is made to the timeline.

Release Notes for Nuke and Hiero 11.0v4 | Other Known Issues



RELEASE NOTES
33

Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/110/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes
• BUG ID 228258 - Python: Calling fromScript on a knob that had not been added caused Nuke to
crash.

• BUG ID 229459 - Python: Calling addDefaultColorspaceMapper did not modify default colorspaces
before they were passed to Readers or Writers.

• BUG ID 247793 - Python: The <install_dir>/pythonextensions/site-packages/hiero/ui/init_.py file
referred to hiero.core.rawArgs incorrectly.

• BUG ID 248250 - Python: Calling nuke.scriptOpen() didn't work as expected when called from the
nukescripts.PythonPanel.knobChanged() function.

• BUG ID 305837 - Python: Re-ordering menu items using the index= variable did not work as
expected when a menu was created inside the nodes toolbar.

• BUG ID 314080 - Python: Calling nuke.clone(nuke.selectedNode(), inpanel=False) ignored the
inpanel flag and created a new panel.

• BUG ID 320558 - Python: Moving or smoothing points in Roto shapes created using Python caused
Nuke to crash.

• BUG ID 327012 - Python: The colorspaces.py file contained inaccuracies that caused callback errors.

• BUG ID 329599 - macOS only: Setting a list of values in an Array_Knob using Python caused Nuke to
crash.
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Release Notes for Nuke and Hiero
11.0v3

Release Date
09 November 2017

Qualified Operating Systems
• Mac OS X El Capitan (10.11) or macOS Sierra (10.12)

• Windows 7 or Windows 10 (64-bit)

• CentOS 6 or CentOS 7 (64-bit)

NOTE: If you intend to use floating licenses with Nuke 11, you'll need to upgrade the version
of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge
Base article Q100320 for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.

NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
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• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA
GPU. Driver version r361 or above is required.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you
don't have it already. The minimum requirement is driver version r361 which can be downloaded
from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

Windows GPU Driver Linux GPU Driver

AMD FirePro W8100 17.Q2.1 AMD FirePro W8100 17.Q2.1

AMD FirePro W9100 17.Q2.1 AMD FirePro W9100 17.Q2.1

AMD Radeon R9 Fury X 17.4.3 - 17.6.2 AMD Radeon R9 Fury X 17.10

AMD Radeon RX 480 17.Q2.1 AMD Radeon RX 480 17.Q2.1

AMD Radeon Pro WX 7100 17.4.3 - 17.6.2 AMD Radeon Pro WX 7100 17.10

NOTE: Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016
MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

MacGPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and
late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-
GPU support option. When enabled in the preferences, GPU processing is shared between the
available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend
updating Mavericks to 10.9.5, or above for full functionality. However:
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• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 143006 - DeepExpression: Nuke's Deep compositing nodes now support most of the math
expression supported by regular nodes. See Nuke's Online Help for more information.

• BUG ID 282546/306265 - Frame Server: Nuke's Preferences now include a frame server render
timeout control, which allows you to increase the number of minutes a render process can stay
unresponsive before ending. If you're experiencing Render application timed outmessages with
process-heavy scripts, you can try increasing this value.

Bug Fixes
• BUG ID 148671 - Importing certain .gif files caused Nuke to crash.

• BUG ID 148823 - Opening an .nk script containing a Keylight or FurnaceCore node in Nuke Assist
checked out a nuke_i license.

• BUG ID 159103 - The obsolete .fpi format was available in transcode Exports and Write nodes.

• BUG ID 163582 - DeepExpression: The pow() function did work as expected.

• BUG ID 226059 - Linux only: Importing CameraTracker user tracks in a customer script caused Nuke
to become unresponsive.

• BUG ID 229381 - Monitor Output: AJA Io4K/IoXT cards were not discoverable with certain legacy
drivers.

• BUG ID 241846/267282 - Monitor Output: Selecting Full Resolution Stereomode in the Monitor
Output panel caused Nuke Studio to crash.

• BUG ID 266361 - Linux only: The HistEQ node caused Nuke to crash with NaN value errors.

• BUG ID 297466 - Monitor Output: ProRes and MP4 encoded shots did not play back correctly.

• BUG ID 303838 - Create comp: Opening a comp containing soft effects and then adjusting an effect's
Properties caused Nuke Studio to crash.

• BUG ID 304724 - Timeline Disk Caching: Enabling disk caching during playback and then scrubbing
the playhead caused Nuke Studio to crash.
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• BUG ID 304994 - macOS only: Using the Cmd+A keyboard shortcut to Select All in the Dope Sheet or
Curve Editor selected all the nodes in the Node Graph.

• BUG ID 305416 - macOS only: Enabling GPU acceleration in a Denoise node on machines with
multiple GPUs caused Nuke to crash.

• BUG ID 305898 - Timeline Disk Caching: Changes to edits were discarded when the root directory
was changed and then restored to the default directory.

• BUG ID 306601 - Timeline Disk Caching: The disk caching feature was not fully disabled when an
invalid database was detected.

• BUG ID 307062 - The | (pipe) keyboard shortcut, snap selected to grid, did not work as expected.

• BUG ID 307378 - CornerPin: The Copy 'from' and Copy 'to' knob names were identical.

• BUG ID 308133 - Create Comp: Double-clicking a comp container occasionally opened the Node
Graph in a floating pane.

• BUG ID 308411 - Opening certain scripts with use GPU for Viewer when possible enabled in the
Preferences caused Nuke to crash.

• BUG ID 308579 - Licensing: The trial license period was incorrect in the Licensing dialog.

• BUG ID 309436 - A customer script with no red channel in the RGBA channel set caused Nuke to
crash.

• BUG ID 309669 - Windows only: Launching Nuke 11 without having first installed a previous major
release (such as Nuke 10.5v6) displayed ../init.py: error interpreting this plugin at start up.

• BUG ID 310031 - Linux only: Importing stereo .exr files caused Nuke Studio to crash.

• BUG ID 310259 - Switching workspace caused Nuke to crash on exit.

• BUG ID 310390 - Timeline Editing: Copying and pasting a shot in the timeline and then dragging the
shot onto a new track caused Nuke Studio to crash.

• BUG ID 310880 - Expressions: A height scaling expression, derived from a Tracker node, incorrectly
scaled width instead of height when linked to a Transform node.

• BUG ID 311682 - Denoise: Adjusting the sample widget in Denoise caused Nuke to crash if the Nuke
temp directory was empty.

• BUG ID 313627 - Nuke Assist requested a nuke_i license due to the Frame Server running in the
background.

• BUG ID 315514 - Viewer: Adding custom guides, by copying and editing ../pythonextensions/site-
packages/custom_guide.py, caused Nuke to crash.

• BUG ID 316252/316253 - macOS/Linux only: Rendering with a fresh cache directory specified by the
NUKE_TEMP_DIR environment variable displayed errors in the first instance.
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Linux Monitor Output Only

NOTE: The fixes for these bugs rely on a version of the AJA monitor output driver that is not
yet available commercially. Please contact AJA Support for details of the correct driver
required for Linux distributions.

• BUG ID 281752 - Selecting Full Resolution Stereomode in the Monitor Output panel occasionally
displayed a CNTV2Card: IOCTL_NTV2_AUTOCIRCULATE_CONTROL failed error.

• BUG ID 271817/251542 - Selecting Full Resolution Stereomode in the Monitor Output panel
produced inconsistent results in the left and right views.

• BUG ID 253659 - Selecting Full Resolution Stereomode in the Monitor Output panel did not output
the correct color values.

Release Notes for Nuke and Hiero 11.0v3 | Bug Fixes

https://www.aja.com/support/contact


RELEASE NOTES
40

Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/110/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.

Release Notes for Nuke and Hiero 11.0v3 | Developer Notes

https://www.thefoundry.co.uk/products/nuke/developers/110/ndkdevguide/appendixc/index.html


RELEASE NOTES
41

Bug Fixes
• BUG ID 238647 - Python: urllib2.py displayed SSL errors when looking for an expired link.

• BUG ID 308316 - macOS only: Assigning the Ctrl or Cmd keyboard shortcut to the
nuke.createNode() command for nodes in the toolbar replaced the selected node, rather than
appending the new node.

• BUG ID 316332 - Python: LiveGroups could not be published if they employed the filnameFilter
function as a Callback between different operating systems.

Release Notes for Nuke and Hiero
11.0v2
Release Date
31 August 2017

Qualified Operating Systems
• Mac OS X El Capitan (10.11) or macOS Sierra (10.12)

• Windows 7 or Windows 10 (64-bit)

• CentOS 6 or CentOS 7 (64-bit)

NOTE: If you intend to use floating licenses with Nuke 11, you'll need to upgrade the version
of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge
Base article Q100320 for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.
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NVIDIA

An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.

• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA
GPU. Driver version r361 or above is required.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you
don't have it already. The minimum requirement is driver version r361 which can be downloaded
from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

Windows GPU Driver Linux GPU Driver

AMD FirePro W8100 17.Q2.1 AMD FirePro W8100 17.Q2.1

AMD FirePro W9100 17.Q2.1 AMD FirePro W9100 17.Q2.1

AMD Radeon R9 Fury X 17.4.3 - 17.6.2 AMD Radeon R9 Fury X 17.10

AMD Radeon RX 480 17.Q2.1 AMD Radeon RX 480 17.Q2.1

AMD Radeon Pro WX 7100 17.4.3 - 17.6.2 AMD Radeon Pro WX 7100 17.10

NOTE: Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016
MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.
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MacGPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and
late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-
GPU support option. When enabled in the preferences, GPU processing is shared between the
available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend
updating Mavericks to 10.9.5, or above for full functionality. However:

• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
There are no feature enhancements in this release.

Bug Fixes
• BUG ID 146580 - Timeline: The RAM cache (white bar) was cleared when the Viewer gamma or gain
controls were adjusted.

• BUG ID 156851/215328/288634 - mov64Reader: Certain DNxHD and ProRes 422 clips flickered during
playback.

• BUG ID 159347 - Linux only: Scrubbing the playhead increased memory usage steadily until Nuke
became unresponsive.

• BUG ID 160266/199070 - mov64Writer: The mov64 codec failed when encoding 24-bit audio.

• BUG ID 161450 - Read: Linux and Mac produced different pixel values to Windows when reading
RAW files.

• BUG ID 198612 - Read: The start time in a customer .mov file differed depending on whether the
mov32Reader or mov64Reader was used.
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• BUG ID 216355 - mov64Reader: Reading files written with the Animation codec produced blurred
images when compared to the mov32Reader.

• BUG ID 219603 - Nuke Studio didn't load the individual default LUT settings when using the OCIO
environment variable to declare a custom configuration file.

• BUG ID 219609 - Export: Enabling a custom OCIO config using the OCIO environment variable and
then disabling it did not remove the preference from the uistate.ini, resulting in invalid color
transforms during export or create comp operations.

• BUG ID 228807 - Camera: The Save button was grayed out in the Export chan file > Chan File
dialog in the Camera node's Properties panel.

• BUG ID 229571 - Read: Attempting to read large, compressed .mov files caused Nuke to crash.

• BUG ID 231646 - Windows only: Enabling GPU processing with an NVIDIA M6000 installed caused
Nuke to crash if the script contained a BlinkScript node.

• BUG ID 248299 - OCIO: Using an OCIODisplay node as a viewerProcess did not display the alpha
channel in the compositing Viewer.

• BUG ID 266187 - Timeline: Reloading a project containing only audio tracks displayed a No Audio
warning in the Viewer.

• BUG ID 266334 - Windows only: Reading in RAW clips displayed the image upside-down.

• BUG ID 268083 - AddTimeCode: The new timecode was added even when the node was disabled.

• BUG ID 272142 - VFX Platform: Using the mouse scroll wheel to edit numeric controls scrolled the
Properties panel.

• BUG ID 272884 - VFX Platform: Closing the Licensing dialog printed errors in the command prompt.

• BUG ID 275038 - Mac OS X/macOS only: The menu bar and Dock were not restored correctly when
switching to the Compositing workspace.

• BUG ID 275906 - ACES: Nuke Studio did not import the correct colorspace for .mov files.

• BUG ID 277875 - VFX Platform: Changing a layout caused it to redraw incorrectly.

• BUG ID 278339 - Mac OS X/macOS only: Key/value pairs could not be selected in the Read node's
Metadata tab.

• BUG ID 279047 - Documentation: Some of the links in Nuke's Helpmenu did not work as expected.

• BUG ID 280788 - Mac OS X/macOS only: Opening a second scope, Histogram or Waveform, in a
workspace containing no scopes by default produced artifacts in the second scope.

• BUG ID 281244 - Metadata: Adding [metadata] to a Text soft effect or node did not display the
following metadata keys:

• hiero/sequence/frame_rate

• hiero/project

• hiero/sequence

• BUG ID 281569 - Timeline Editing: The timeline Viewer See Through Missing Media option was
active for clip instances where media was not OFFLINE.
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• BUG ID 281750 - Mac OS X/macOS only: Scrubbing the playhead caused the current frame line to lag
behind on the timeline.

• BUG ID 282440 - Create Comp: Overwriting an exported .exr sequence caused Nuke Studio to crash.

• BUG ID 282468 - Read/Write: TheMedia tab Colour Space control listed options for .r3d files that
have been removed from the Compositing environment.

• BUG ID 282621/305753 - Timeline Disk Caching: Changing the cache directory discarded cached
frames between In and Out points.

• BUG ID 284061 - Timeline Disk Caching: Caching long sequences occasionally stalled until the
background render process was paused and then restarted.

• BUG ID 286445 - Right-clicking on some controls in the node Properties panel occasionally
displayed two menus on top of each other.

• BUG ID 286547 - Mac OS X/macOS only: Adding a Burn-in soft effect to large shots on the timeline
caused the effect's control sliders to be sluggish.

• BUG ID 297255 - Timeline Disk Caching: Adjusting .r3d or .ari controls in theMedia tab did not
force the disk cache to refresh.

• BUG ID 303733 - Documentation: The application Help > Release Notes link pointed to the wrong
URL.

• BUG ID 303931 - Preferences: Changing the Comp Disk Caching > temp directory path stopped the
application loading.

• BUG ID 304531 - HueCorrect: The hue LUT control's background in the Properties panel was gray,
rather than the full color spectrum.

• BUG ID 305082 - Preferences: Zooming in the Viewer with Panels > Viewer > use GPU for Viewer
when possible enabled drew black handles in the Viewer.

• BUG ID 305898 - Timeline Disk Caching: Changing the Timeline Disk Caching > directory path in
the Preferences and then switching back to the default directory discarded changes to edits on the
timeline.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/110/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

There are no new features in this release.

Feature Enhancements

There are no feature enhancements in this release.
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Bug Fixes
• BUG ID 286759 - Mac OS X/macOS only: The mov64 example in the NDK documentation did not
build using Clang.

• BUG ID 287055 - VFX Platform: Nuke prompted customers incorrectly that Visual Studio 2010 was
required for plug-ins, rather than Visual Studio 2015.
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Release Notes for Nuke and Hiero
11.0v1

Release Date
24 July 2017

Qualified Operating Systems
• Mac OS X 10.11 (El Capitan) or macOS Sierra (10.12)

• Windows 7 or Windows 10 (64-bit)

• CentOS 6 or CentOS 7 (64-bit)

NOTE: If you intend to use floating licenses with Nuke 11, you'll need to upgrade the version
of RLM used in the Foundry Licensing Tools (FLT) on your server. See Foundry Knowledge
Base article Q100320 for information.

Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration

If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.

NVIDIA

• an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.

NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.

With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
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• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your
NVIDIA GPU. Driver version r361 or above is required.

Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.

• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if
you don't have it already. The minimum requirement is driver version r361 which can be
downloaded from www.nvidia.com/drivers.

NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

AMD

• On Windows and Linux, an AMD GPU and driver from the following list:

Windows GPU Driver Linux GPU Driver

AMD FirePro W8100 17.Q2.1 AMD FirePro W8100 17.Q2.1

AMD FirePro W9100 17.Q2.1 AMD FirePro W9100 17.Q2.1

AMD Radeon R9 Fury X 17.4.3 - 17.6.2 AMD Radeon R9 Fury X 17.10

AMD Radeon RX 480 17.Q2.1 AMD Radeon RX 480 17.Q2.1

AMD Radeon Pro WX 7100 17.4.3 - 17.6.2 AMD Radeon Pro WX 7100 17.10

NOTE: Other AMD GPUs may work, but have not been fully tested.

• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016
MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

MacGPUs

Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and
late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-
GPU support option. When enabled in the preferences, GPU processing is shared between the
available GPUs for extra processing speed.

NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend
updating Mavericks to 10.9.5, or above for full functionality. However:
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• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.

• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features

VFX Platform 2017 Compliance

This is a significant update to Nuke's core libraries and numerous third party libraries, with the aim to
provide a common target platform for building software for the VFX industry. For more information
on the library versions shipped with Nuke 11, see Appendix D in the Online Help.

AAF Import

Nuke Studio and Hiero now support non-linear retimes imported from Avid Media Composer in the
.aaf format. Retimes exported from Avid are converted to Timewarp soft effects in the timeline so
that you can adjust them in the Curve Editor if necessary.

Expanded AMD GPU Support

Nuke’s OpenCL support has been expanded on Windows and Linux operating systems. As a result,
certain AMD GPUs are now compatible with Nuke, giving you more choice in the hardware you use.
See Requirements for Nuke's GPU Acceleration for more information.

ARRIRAW and R3D SDK

The ARRIRAW and R3D SDKs have been updated as part of the VFX Platform 2017 work. The new
library versions are ARRIRAW 5.3 and R3D 6.2.2.

NOTE: Nuke does not currently support ARRIRAW files in the .mxf format, such as those
from the ARRI ALEXA Mini. Support for .mxf files is scheduled for a future release.

Denoise

Denoise now includes a temporal processing option, which can help to improve results by averaging
the noise reduction over several frames, instead of just a single frame.
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Frame Server in Nuke

Nuke Studio's Frame Server is now available in Nuke and NukeX, allowing you to reduce render times
by sharing work over the number of render processes specified in the Preferences. You can also use
external machines as render slaves. The Frame Server logs renders in the Background Renders
panel, including information such as script name, Write node, frame range, progress, and whether or
not the render produced errors.

The Frame Server is disabled by default, but you can enable it in the Preferences >
Threads/Processes or on a per render basis in the Write node's Render dialog.

Latest Operating System Support

Nuke 11 is qualified on the following operating systems:

• Mac OS X 10.11 (El Capitan) or macOS Sierra (10.12)

• Windows 7 and 10 (64-bit)

• CentOS 6 and 7 (64-bit)

Other operating systems may work, but have not been fully tested.

LensDistortion

NukeX and Nuke Studio's LensDistortion node has been improved and streamlined for ease of use. It
includes support for spherical and anamorphic lenses and a number of presets and distortion
models, and displays the Distortion Equations for the selected lens type. You can estimate the
distortion in an image using automatic Grid Detection or draw curves in the Viewer manually to solve
the lens. The node also allows you to output STMaps in themotion channel for use elsewhere in the
script.

LiveGroups

LiveGroups are a type of container node that can be used in conjunction with LiveInput nodes so that
multiple artists can work on different parts of the same shot as separate scripts, without the need for
rendering. LiveGroups also offer all the functionality of Precomps, Groups, and Gizmos combining all
the functionality that they lack individually.

Just like Precomps, LiveGroups can store independent, open source .nk files, allowing you to save a
subset of the node tree as a separate .nk script, render the output of this saved script, and read the
rendered output back into the master comp as a single image input.
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You can also use LiveGroups like Group nodes to nest multiple nodes inside a single node. The
original nodes are replaced with the LiveGroup node. When you create a LiveGroup node, its internal
structure is shown in a separate Node Graph tab.

Smart Vector Toolset Improvements in NukeX

The SmartVector toolset's SmartVector node can now export a Write node to calculate vectors in the
background while you're working.

Additionally, the VectorDistort node now includes a new blur size control, which can help remove
micro distortions. This is particularly useful when propagating thin or fine structures over time.

Timeline Disk Caching

Timeline Disk Caching provides reliable playback for more complex timelines by rendering frames to
disk using the GPU. The cache provides persistent frames per edit in the timeline that only needs
updating for full changes on the edit, such as adding a soft effect. For editorial changes, only the new
frames need to be cached.

New Toolsets

The ready-made example scripts in the Toolsets menu have been updated and split into two broad
categories: 2D and 3D. The ToolSets give you access to several examples of common compositing
tasks, such as multipass rendering from common third-party renderers, keying, particle systems, and
rig removal. See ToolSets Nodes for more information on the examples that ship with Nuke.

The scripts also contain a link to footage you can download to use with the examples:

http://thefoundry.s3.amazonaws.com/products/nuke/toolsets/toolset_examples.zip

Truelight

FilmLight and Foundry have elected to no longer bundle Truelight as of Nuke 11. The Truelight node
has been superseded by the free version of Baselight for Nuke which itself can import a BLG
(Baselight Linked Grade) that can contain a Truelight strip, plus optionally a lot more in terms of
creative grading intent. Together with OpenColorIO and the native Nuke Vectorfield node we feel all
the Nuke color management issues for which the Truelight node was originally intended are now
addressed.

For further information on Baselight for Nuke, please contact plugin-support@filmlight.ltd.uk
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Feature Enhancements
• BUG ID 138125 - Precomp: Scripts containing Group nodes with a Write node inside now
automatically connect the Write to the Output of the Precomp node.

• BUG ID 278084 - TheMailing Lists option under Nuke's Helpmenu has been replaced by a link to
the Foundry Forums, allowing you to keep in touch with the Nuke community more easily.

Bug Fixes
• BUG ID 151676 - Linux only: Running NVIDIA GPUs in high bit-depth (30-bit) mode made the UI
visually unstable.

• BUG ID 161942 - DeepExpression: The < and > comparators were both evaluated as < (less than).

• BUG ID 218316 - ARRIRAW: The arriReader did not support the full range of integers (-12 to +12) for
the tint control.

• BUG ID 242501 - ARRIRAW: Reading certain .ari files displayed resolution not supported in
current ArriSDK version in the Viewer.

• BUG ID 250117 - Export: Certain sequences could not be exported using the Frame Server.

• BUG ID 252438 - Windows only: Resizing panels during playback created multiple instances of the
panel and lowered the framerate.

• BUG ID 263006 - AAF: ExecutingMatch Media on certain imported .aaf sequences did not conform
some clips.

• BUG ID 264028 - Mac OS X El Capitan only: Dragging handles in the 3D Viewer was slower to update
than in previous versions of Nuke.

• BUG ID 266672 - AAF: Negative retimes imported from .aff files were displayed incorrectly in the
timeline Viewer.

• BUG ID 266911 - AAF: Freeze frames were displayed as missing data.

• BUG ID 267674 - BlinkScript: Default values could not be changed for float4x4matrix and float3x3
matrix in BlinkScript kernels.

• BUG ID 269346 - AAF: Percentage values on certain imported linear retimes were incorrect.

• BUG ID 269873 - Particles: Rendering multiple views from the P_RainBox toolset did not work as
expected.

• BUG ID 272604 - Documentation: The Frame Server slave command, --nukeworkerthreads, was
listed incorrectly as --numworkerthread.

• BUG ID 272637 - AAF: Retimed clips with embedded, pre-rendered media imported from Avid Media
Composer were the wrong length.

• BUG ID 272639 - AAF: Timewarp soft effects imported from .aaf files displayed an error when not at
the beginning of the sequence.
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• BUG ID 273865 - AAF: Timewarp effects on shots after the first shot in the sequence displayed an
error.

• BUG ID 274615 - Unknown nodes in scripts, such as custom OFX plug-ins, were not replaced by
NoOp nodes on script load if they didn't specify xpos and ypos values.

• BUG ID 274679 - BlinkScript: The Rolling Kernel example in the Blink Reference guide contained an
error.

• BUG ID 274964 - AAF: Importing multiple clips with linear retimes did not mirror the order exported
from Avid Media Composer.

• BUG ID 275195 - The text on the Crash Reporter dialog referred to the old Foundry Support address.

• BUG ID 275271 - AAF: Cropped clips contained missing frames when imported into Nuke Studio.

• BUG ID 275630 - AAF: Negative retimes included a frame offset when the source clips had no
handles.

• BUG ID 275720 - Linux CentOS 7 only: The Export Queue magnifying glass button did not work as
expected.

• BUG ID 275854 - AAF: Imported retimes ignored anchor keyframes.

• BUG ID 277333 - AAF: Imported shots were truncated when compared to the source.

• BUG ID 278078 - The --remap command line argument's error messages contained typographic
inaccuracies.

• BUG ID 278106 - Audio: Retiming and then slipping audio shots past the start of the shot caused
Nuke Studio to crash or rendered the waveform incorrectly.

• BUG ID 282239 - Read/Write: The tooltip for .r3d files color space control was out of date.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/110/ndkdevguide/appendixc/index.html for more
information.

As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.

Release Type Example Compatibility Recompile Rewrite

Version 10.0v1 to 10.0v2 API and ABI

Point 10.0v1 to 10.5v1 API

Major 10.0v1 to 11.0v1 -

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.

As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:

m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features

VFX Platform 2017 Compliance

This is a significant update to Nuke's core libraries and numerous third party libraries, with the aim to
provide a common target platform for building software for the VFX industry. For more information
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on the library versions shipped with Nuke 11, see Appendix D in the Online Help.

Feature Enhancements

There are no feature enhancements in this release.

Bug Fixes

There are no bug fixes in this release.
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